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1 Introduction 

1.1 The Motor Vehicle Emissions Inventory 

An emissions inventory is a critical element in the control of air pollution and the attainment 
of national and state ambient air quality standards. It is also an essential tool in developing 
regulations and control strategies to fulfill the California Air Resources Board’s (CARB) 
mission to promote and protect public health, welfare, and ecological resources through 
the effective and efficient reduction of air pollutants while recognizing and considering the 
effects on the economy of the state. 

An emissions inventory (for any source category) can be calculated, at the most basic level as 
the product of an emission rate, expressed in grams of a pollutant emitted per some unit of 
source activity, and a measure of that source’s activity. 

 The following expression illustrates this basic relationship between the emissions rate and 
source activity used to calculate emissions: 

𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄 𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅𝐅 × 𝐒𝐒𝐒𝐒𝐒𝐒𝐒𝐒𝐒𝐒𝐒𝐒 𝐀𝐀𝐀𝐀𝐀𝐀𝐀𝐀𝐀𝐀𝐀𝐀𝐀𝐀𝐀𝐀 =  𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄𝐄 

For on-road motor vehicles, emissions rates are typically expressed as mass of pollutant 
emitted per mile driven, per vehicle per day, or per trip made, depending on the emissions 
process being analyzed. An emissions process for a motor vehicle is the physical mechanism 
that results in the emissions of a pollutant (e.g., the combustion of fuel, the evaporation of 
fuel, tire or brake wear, or the start of an engine). 

CARB developed an EMission FACtors (EMFAC) model to calculate statewide or regional 
emissions inventories by multiplying emissions rates with vehicle activity data from all motor 
vehicles, including passenger cars to heavy-duty trucks, operating on highways, freeways, 
and local roads in California. 

1.2 EMFAC2025 

Over the years, tougher emissions standards have been met with technological solutions of 
increasing complexity. As a result, the emissions estimation models have also grown in size 
and complexity. 

EMFAC2025 is the latest emissions inventory model that calculates emissions inventories for 
motor vehicles operating on roads in California. EMFAC2025 represents the next step 
forward in the ongoing improvement process for EMFAC and reflects the CARB’s current 
understanding of how vehicles travel and how much they pollute. The EMFAC2025 model is 
needed to support CARB’s planning and policy development efforts and to meet the 
Federal Highway Administration’s transportation conformity requirements. 
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The EMFAC2025 model can be used to show how California motor vehicle emissions have 
changed over time and are projected to change in the future. This information helps CARB 
evaluate prospective control programs and determine the most effective, science-based 
proposals for protecting the environment. 

EMFAC2025 includes the latest data on California’s car and truck population, activity, and 
emission testing. New model features are added to reflect additional fuel and technologies, 
including modules to show emissions from fuel cell electric vehicles (FCEV) as outputs for 
hydrogen consumption. EMFAC2025 also incorporates all the most recently adopted on-
road mobile source regulations. More details about the updates in emissions calculation 
methodologies and data are available in the EMFAC2025 Technical Documentation. 

Figure 1.2-1 displays a flow chart indicating the GUI selections necessary to generate the 
various outputs of EMFAC2025. The Emissions Mode can be used to estimate tons of 
emissions per day and the Emission Rate Mode can be used to estimate grams of emission 
per unit of activity. The Custom Activity (SG) mode can be used to estimate tons of emission 
per day with customized activity from the end-users. 

Figure 1.2-1 EMFAC2025 Overall Flow 

 

1.3 About this Document 

The purpose of this EMFAC2025 User’s Guide is to familiarize users with the features and 
controls in the EMFAC2025 model. More information regarding the methodologies and      
data used in EMFAC2025 to estimate emissions and emission rates will be made available in 
the EMFAC2025 Technical Documentation. 
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2 Pollutants, Activities, and Processes Modeled  

This section describes the pollutants and emissions processes currently modeled in 
EMFAC2025. 

2.1 Pollutants  

The model calculates emissions factors and emissions inventories for the 
following primary pollutants: 

• Carbon monoxide (CO) 
• Nitrogen oxides (NOx) 
• Hydrocarbons (HC): HC can be expressed as TOG (total organic gases), ROG 

(reactive organic gases), THC (total hydrocarbon), or CH4 (methane). The THC class 
includes compounds with H and C atoms only, carbonyls and halogens are not 
included in the class. The TOG class includes all organic gases emitted into the 
atmosphere. The ROG class is the same as EPA’s Volatile Organic Compounds (VOC) 
definition and does not contain compounds exempt from regulations. 

• Particulate matter (PM): Particulate matter estimates are provided for total suspended 
particulates (PM), with diameter 10 microns or less (PM10), and with    diameter 2.5 
microns or less (PM2.5). 

• Sulfur oxides (SOx): Emissions of oxides of sulfur are a function of the sulfur content of 
fuel. The model calculates these emissions by multiplying the fuel consumption by 
the weight fraction of sulfur in a gallon of fuel. 

• Fuel: Although fuel is not a pollutant, fuel consumption is calculated based on the 
tailpipe emissions of CO, CO2 and THC using the carbon balance equation. 

• Greenhouse Gases (GHG): GHG emissions consist of complete combustion CO2, 
Nitrous Oxide (N2O) and Methane (CH4). These are the greenhouse gases that are 
included starting from EMFAC2017. 

• Ammonia (NH3): Emission rates of NH3 vary by vehicle class and model year. 

2.2 Activities 

The model estimates and projects vehicle activities and outputs them for the 
following               activities: 

• Vehicle Miles Traveled (VMT): daily VMT is generated in three types, including total 
VMT, cVMT, and eVMT. cVMT represents combustion VMT which is powered by 
conventional fuel, e.g. gasoline, diesel, or natural gas. eVMT represents electric VMT, 
which is powered by electric battery or hydrogen fuel cells. Total VMT is the sum of 
cVMT and eVMT.   Only Plug-in Hybrid Electric Vehicle (PHEV) has both cVMT and 
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eVMT, and the rest of fuel types have either cVMT (gasoline, diesel, and natural gas) 
or eVMT (battery electric and fuel cell electric). 

• Trip: EMFAC defines a trip as an engine-on event. The total number of trips is 
estimated by the number of starts per vehicle and vehicle population. Unlike internal 
combustion engine (ICE) vehicles, PHEVs can use energy from a battery, an ICE or a 
combination of the two to attain propulsion power, and they could invoke the engine 
at any moment within a given trip. The PHEV trip output only includes trips with 
engine-on events. 

• Population 
• Energy Consumption: Energy or electricity consumption is generated in a separate 

.csv file, similar to other activity outputs (e.g. VMT, trip, and population). It is 
estimated based on electricity consumption in kilowatt-hour (kWh) per mile. 

2.3 Emissions Processes 

Emissions (especially HC) emanate from a vehicle during all hours of the day. The 
magnitude of these emissions varies with what is happening with the vehicle, such as 
running on the road, idling at a loading zone, sitting outside in the sun, or just starting. 
Emissions processes account for all emissions of a vehicle across all hours of the day, 
regardless of whether the vehicle is in motion or whether or not it has been started. The 
types of emissions processes in the model are: 

• Running Exhaust Emissions (RUNEX) that come out of the vehicle tailpipe while 
traveling on the road. 

• Idle Exhaust Emissions (IDLEX) that come out of the vehicle tailpipe while it is 
operating but not traveling any significant distance. This process captures emissions 
from heavy-duty vehicles that idle for extended periods of time while loading or 
unloading goods. Idle exhaust is calculated only for heavy-duty trucks. 

• Start Exhaust Tailpipe Emissions (STREX) that occur when starting a vehicle. These 
emissions are independent of running exhaust emissions and represent the emissions 
occurring during the initial time period when a vehicle’s emissions after treatment 
system is warming up. The magnitude of these emissions is dependent on how long 
the vehicle has been sitting prior to starting. Please note that STREX is defined 
differently for heavy-duty diesel trucks than for other vehicles, as they are considered 
as consisting of two parts: 1) running emissions that would otherwise be emitted 
when the SCR system is at a working temperature, and 2) start emissions that only 
exist when the SCR system is below its working temperatures. As a result, start 
emissions for heavy-duty diesel trucks are calculated by subtracting the running-
phase emissions from the starting-phase emissions and multiplying the result by the 
duration of the starting phase. More details can be found in the EMFAC2014 
Technical Documentation. 

• Diurnal Evaporative HC Emissions (DIURN) that occur when rising ambient 
temperatures cause fuel evaporation from vehicles sitting throughout the day. These 
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losses are from leaks in the fuel system, fuel hoses, connectors, as a result of the 
breakthrough of vapors from the carbon canister. Additionally, HC can permeate 
through hoses and connectors. 

• Hot Soak Evaporative HC Emissions (HOTSOAK) that begin immediately from heated 
fuels after a car stops its engine operation and continue until the fuel tank reaches 
ambient temperature. 

• Running Loss Evaporative HC Emissions (RUNLOSS) that occur as a result of  hot fuel 
vapors escaping from the fuel system or overwhelming the carbon canister while the 
vehicle is operating. 

• Tire Wear Particulate Matter Emissions (PMTW) that originate from tires as a result of 
wear. 

• Brake Wear Particulate Matter Emissions (PMBW) that originate from brake usage. 
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3 Installation and Configuration of EMFAC2025 

3.1 System Requirements 

• Operating System: Microsoft Windows 10 and Windows 11 
• Disk Storage: 

o EMFAC2025 application itself requires 1 GB disk space. 
o The default MySQL database used by EMFAC2025 will require 5 GB disk space. 
o At least 50 GB of free disk space is recommended for running EMFAC2025. 

The amount of space required varies depending on the level of detail in the 
output, the number of sub-areas and calendar years, and the number of runs. 

o The performance of EMFAC2025 depends on the performance of MySQL 
server. For fast EMFAC runs, we recommend running MySQL server on a 
computer with multiple CPU cores and a high-performance storage (e.g. Solid 
State Drives). 

3.2 Pre-Installation Notes 

• EMFAC2025 requires MySQL Community Server 8.0 or higher. Older versions are not 
officially supported. You can find more information about getting and installing 
MySQL software at the official MySQL website: https://www.mysql.com 

• Please do not make any changes to the EMFAC default database on the MySQL 
server. The model may fail or generate erroneous results if changes are made to the 
database. 

3.3 Model Installation 

Extract the EMFAC2025 package to a folder of your choice on your local drive (for example, 
C:\EMFAC2025). 

3.4 Model Configuration 

1. Double click “EMFAC.exe” within the installation directory or click the icon on the 
taskbar or start menu, to start EMFAC2025. The program will display a page that asks 
users to configure MySQL settings first using the MySQL Configurator. You may safely 
ignore any Microsoft Windows security or antivirus warning related to the 
EMFAC2025 software package. 

a. If presented with this message: 

https://www.mysql.com/
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b. Right click the application, open up properties, and check “Unblock”: 
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2. Click the “Configure MySQL” button to bring up the pop-up window shown below. 
This configuration is needed for the installation of an updated model or when the 
configuration of MySQL is changed. 

3. Enter the “MySQL Username” and “MySQL Password” 
4. Enter the “MySQL DB Prefix” with a prefix that will be added to all the databases 

created by EMFAC. 
5. A suggested value of “# of parallel MySQLs” is provided based on the number of CPU 

cores available on the PC where you ran EMFAC. Change this value properly based 
on the available number of CPU cores and the performance of your MySQL server. 
 

 
 

6. Click “Test” to test. 
7. Click “Save” when the configuration is set correctly. 
8. Click “Import EMFAC Default Database” to import the databases to your MySQL 

server.  
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9. Please note that a user can reconfigure a previously configured EMFAC2025/MySQL 

connection by launching the MySQL Configurator from the Tools menu. This 
functionality could be used, for instance, to connect EMFAC to a different MySQL 
server. 

10. Once the import is finished, click “Click to Get Started” to enter the main menu of 
EMFAC2025. 
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3.5 EMFAC Command-Line Interface 

• EMFAC2025 includes a command-line interface to facilitate batch mode operation. 
Open a Command Prompt or PowerShell in Windows and navigate to the folder 
containing “EMFAC.exe” executable. Here, we assume the folder is C:\EMFAC2025 
as an example. 

• Running “.\EMFAC.exe” without any options will launch the GUI application: 

C:\EMFAC2025>.\EMFAC.exe 
 

• Executing the command below will show all the available options for the application: 

C:\EMFAC2025>.\EMFAC.exe -h 
 
usage: emfac [-h] [-c] [-C] [-m MYSQL_CONFIG_TOML] [-i INPUT_FOLDER] [-o 
OUTPUT_FOLDER] [-l LOGFILE] [-s] [-r] [-X] 
 
Command Line Interface for EMFAC2025 v2.0.0 
 
options: 
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  -h, --help            show this help message and exit 
  -c                    Run EMFAC in the command line mode 
  -C                    Drop all existing working schemas 
  -m MYSQL_CONFIG_TOML  MySQL DB configuration (default: emfac_mysql.cfg.toml) 
  -i INPUT_FOLDER       Input folder (default: input) 
  -o OUTPUT_FOLDER      Output folder (default: output) 
  -l LOGFILE            Log file (default: EMFAC.log) 
  -s                    Keep final output tables in MySQL 
  -r                    reset or import all default tables 
  -X                    drop all EMFAC databases 

 

• EMFAC command-line interface requires a MySQL configuration file. In order to use a 
single MySQL server, please create a “emfac_mysql.cfg.toml” text file with the 
following content: 

 
[MySQL] 
host = "mysql_server_hostname" 
port = 3306 
username = "dbuser" 
password = "dbpassword" 
dbprefix = "emfac" 
ncore = 2 
compression = false 

• In order to run EMFAC using multiple MySQL servers, create a 
“emfac_mysql.cfg.toml” text file with the following format: 

[[MySQL]] 
host = "mysql_server1_hostname" 
port = 3306 
username = "dbuser" 
password = "dbpassword" 
dbprefix = "emfac" 
ncore = 2 
compression = false 
 
[[MySQL]] 
host = "mysql_server2_hostname" 
port = 3306 
username = "dbuser" 
password = "dbpassword" 
dbprefix = "emfac" 
ncore = 2 
compression = false 
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• To run EMFAC in command line mode, please add one or more “_ers.toml” files in 
“input” folder, then run emfac using “-c” option and output files will be generated in 
“output” folder: 

C:\EMFAC2025>.\EMFAC.exe -c 

 

• As hinted in “emfac.exe -h” output, “input” or “output” folder location can be changed 
using “-i” or “-o” option. EMFAC MySQL configuration file can be specified using “-m” 
option. The MySQL configuration file uses the Tom's Obvious, Minimal Language 
(TOML) format. 
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4 Getting Started with EMFAC2025 

4.1 General Tips 

• The console shows the status of the model and error messages, if any. 
• Consecutive items can be selected by shift-clicking and non-consecutive items can be 

selected by control-clicking in the list boxes. 
• The unit for fuel output is 1000 gallons/day. The fuel unit for natural gas vehicles is in 

diesel equivalent gallon (DEG). 
• The units for the output of the GHG module are detailed as follows. Column 

“emission”: in tons/day and in thousand gallons/day where the "pollutant" is fuel. 
Column “emission_annualized”: in tons/year and in thousand gallons/year where the 
"pollutant" is Fuel. Column “CO2e”: in tons/day. Basically, it is to be consistent with 
the EMFAC model's historical convention: all emissions are in short tons and fuel 
consumption is in thousand gallons. There is one column that is additionally added in 
GHG outputs: column “CO2e_annualized” in metric tons per year. This is to facilitate 
comparison with existing literature which reports CO2e using metric tons or even  
million metric tons such as those in Scoping Plan. Note that 1 ton = 0.907185 metric 
tons. 

• In order to manage the size of the output files, some emissions and emission rates 
that are equal to zero are not included in the output files. Therefore, in instances 
when data are missing in the output file, the user can assume zero emissions or an 
emission rate of zero. 

• When canceling a run, the program will try to terminate all the active queries, some 
may not stop immediately. But pressing the cancel will not remove the main GUI and 
the console. It only removes the running dialogue. 

 

 

Note! 

1. Do not close the console while the model is running. 
2. Limit the number of areas and calendar years and level of 

details selected for one run to manage the run-time of the 
current run and the size of the output. 

3. Splitting big runs into small runs is strongly recommended. 
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4.2 Graphical User Interface 

4.2.1 Menus 

• There are four menus in the parent, Home Screen window of EMFAC2025: “File”, 
“Run”, “Tools” and “Help”. 

 
• The File Menu has four actions: “New” (new run), “Open” (open a saved run 

specification), “Save” (save a run specification), and “Exit.” Upon starting the program, 
the program automatically assumes the user is creating a new run and thus the parent 
window displays the Home Screen. One may choose to open a previous run by 
selecting “Open” in the File Menu and then selecting the appropriate file. 

• The Exit action of the File Menu will only work in EMFAC2025 if a calculation is not 
being made. If calculations are occurring, cancel the run first, and then exit. 

• The Run Menu has one action: “Run EMFAC.” 
• The Tools Menu has one action: “MySQL Configurator.” 
• The Help Menu has an “About…” action that will tell the user what EMFAC version is 

running 
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4.2.2 Home Screen, Run Modes and Types 

• The Home Screen (below) is automatically displayed after the model starts or when 
“New” is selected from the File Menu. 

 

• “Run Mode” and “Run Type” are the selection options in this “New” tab. There are two 
different Run Modes: “Emissions” and “Emission Rates.” 

• Under the “Emissions” run mode, two Run Types are available. “Default Activity” runs 
use default EMFAC activity data, while the “Custom Activity (SG)” run type allows 
users to use their own activity data to run the model. The “Custom Activity (SG)” run 
type was formerly known as “SG” or “Scenario Generator”. It can be used to generate 
an input activity data file template or to load custom activity data to produce an 
emissions inventory for transportation planning, a SB375 report, etc. 

• Under the “Emission Rates” run mode, only one Run Type is available. The ‘’Project-
Level Assessment (PL)” run type can be used to calculate emissions rates with inputs of 
meteorological conditions for project-level assessments. 
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5 Generating Emissions Inventories 

For regional analyses (as opposed to project-level analyses), there are two 
different modes in EMFAC2025 dictated by the travel activity data that are 
used. 

Default Activity Mode. EMFAC uses historical data and future forecast to 
estimate EMFAC’s default VMT to represent CARB’s best estimates of California’s 
on-road mobile source emissions inventory. 

Custom Activity (SG) Mode. EMFAC allows users to generate emissions inventories using 
custom VMT information. Metropolitan and regional planning agencies can use this feature 
to generate emissions inventories that can be used for State Implementation Plans (SIP), 
transportation conformity analysis, and others. 

 

5.1 Using Default Activity Mode 

In this section, we explain how to accomplish an Emissions run with Default 
Activity either from the home screen or by loading an EMFAC2025 “_ers.toml” file 
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that is saved from a previous run. The run parameters for default emissions run are 
summarized in Appendix 8.1. 

5.1.1 Starting a Default Activity Run 

1. Go to the Home screen by either restarting the model or clicking “New” in the File 
Menu. 

2. Pick “Emissions” and “Default Activity” and click “Start”. 
• This takes the user to a window with four tabs (next page); the Area tab, the Time 

tab, the Vehicles tab, and the Output tab. 

5.1.2 Area Tab 

 

• The Area tab’s list boxes allow users to choose different area types and 
areas for analysis. The user may pick from one of six area types: 
Statewide, Air Basin, Air District, MPO, County, or Sub-Area. Please 
refer to Appendix 8.2 for area definitions.  
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• The user may pick only one Area Type but has the option of selecting multiple 
Areas within the chosen Area Type by holding the Ctrl key while clicking on an 
area. 

• For example, “Air Basin” has been selected in the following window, so multiple 
selections can be made (see figure). 
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5.1.3 Time Tab 

• In the “Time” tab, a single Calendar Year or multiple can be selected: 
however, only one Season or Month can be selected for each run. 
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Calendar y 
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5.1.4 Vehicles Tab 

 

• In the Vehicle Class list box, the user can select the vehicle classes of interest. All 
vehicles can be selected by clicking “Select All”. EMFAC202Y, EMFAC202X, 
EMFAC2011 , , and EMFAC2007 Vehicle Classes are available. Note that “EMFAC202Y 
Vehicle Class” is newly added in this version of EMFAC. Please refer to Appendix 8.3 
for definitions of vehicle categories. 

• The data can be output in either “By Model Year” or “Aggregated” form. 
• The user can choose to output the data “By Speed” (for output at each speed) or 

“Aggregated” (for combined output only). 



26 

 

5.1.5 Output Tab 

 

• The “Pollutants” group box allows users to choose pollutants to be included in the 
output.  

• The “Activities” group box indicates the types of activity data to be included in the 
output.  

• The “Options” group box allows users to choose “Output by Process” to output data 
per emissions process (e.g., Running Exhaust Emissions, or Start Exhaust Tailpipe 
emissions) or to choose “Output by Cat-NonCat” for output per catalyst-equipped 
and non-catalyst-equipped groupings. 

• The “Save Data” group box selection indicates whether the output data from the 
current run is saved in the MySQL server for reuse by the same future runs or their 
subsets. This does not affect model outputs. 

• The “Output Options” group box allows users to: 1) split the model output into 
separate files based upon Sub-Area and Calendar Year to keep the size of the output 
files manageable; 2) specify a different directory to hold the output files other than 
the default directory (e.g. “C:\EMFAC2025\output”) by clicking the  “Change 
Directory” button. 
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• The standard output format for a Default run is “CSV” (comma-separated value text 
files). The output files will have a numerical timestamp in the name of the files. 

5.1.6 Starting the Model Run 

• Click “Run EMFAC”, in the Run Menu, or the “Run” button at the lower right corner of 
the Output tab to start the model run. 

5.1.7 Saving the Run Specification 

• Save the “Run Specification” (as “_ers.toml” files) for future use after all the run 
parameters have been determined. Click “Save” in the file menu or click “OK” in the 
pop-up window after the run button is clicked to save the _ers.toml file. 

 

5.1.8 Once the Run Has Started 

• The time it takes to finish a run depends on how many sub-areas and calendar years 
were selected, the aggregation level specified for the output files, and the 
performance of the computer. 

• The model run can be stopped by clicking “Cancel” in the EMFAC2025 window. 
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• Once the model run is done, the following window provides the names and locations 
of the output files generated after the run has finished.  



29 

 

• A default emissions run file name will consist of the EMFAC2025 label, sub-area, the 
analysis year, the season, data type (emission, GHG, VMT, energy consumption, 
vehicle population, and trips), and the time when the output file was generated. The 
user has the option to modify the first half of the filenames to their own naming 
standards when saving the run specification. However, the data type and output file 
generation time will still be indicated at the end of filename. 

 

5.1.9 Starting Default Run Using a Saved _ers.toml File 

• Click “Open” in the File Menu to load the file. 

 
• The run parameters will be loaded to the model and can be modified and saved as a 

new _ers.toml file by clicking “Save” in the File Menu. 

5.2 Using Custom Activity Mode (SG) 

5.2.1 Background 

The Custom Activity (SG) Mode of EMFAC2025 is designed to perform emissions 
assessments for determining conformity with the state implementation plan and for 
compliance with SB375 targets. Both types of assessments are most often done by various 
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planning agencies and air districts throughout California. These assessments require the 
user to create custom activity data files containing vehicle miles travelled (VMT) and/or 
speed profile data. This customized activity data will then be used for scaling the default 
vehicle emissions produced by EMFAC2025. 

5.2.2 Saving Output Data from a Run for Future Use 

As a way to reduce computational time, the model allows the output data from the current 
run to be saved for future use if “Save data from this run for future use” is selected in the 
Output tab. This works for both Default Activity Runs as well as Custom Activity (SG) runs. 

Data saved from previous runs can be used if one or more of the three criteria are met: 

1. The current run has exactly the same run parameters as one of the previous runs that 
have output saved. 

2. The run parameters (Calendar Years, Areas) of the current run are a subset of 
parameters of one of the previous runs that have output saved. 

3. The current run has fewer details or is more aggregated than the previous runs with 
saved output. 

Model run time is significantly reduced when the saved output from previous runs option is 
used for the current run. Extracting data already stored in the model database is much 
faster than recalculating it. 

5.2.3 Types of Custom Activity Data 

EMFAC2025 requires SG templates to be generated by EMFAC2025, not by older versions. 

For all types of SG templates, the names of the worksheets MUST be exactly the same as 
produced from EMFAC. EMFAC uses these worksheet names to identify what type of data is 
present and worksheets with any other names will be ignored. The user must provide either 
daily total VMT or daily total VMT by vehicle-tech. Speed fraction profiles are optional. 

EMFAC can import multiple sets of activity data at one time. Also, EMFAC can only process 
data for multiple scenarios with the same type of area and season. Files with different area 
types or seasons or SB375 settings cannot be loaded together. That is, one cannot run a 
scenario with the SCAG MPO and the Lake Tahoe Air Basin, since the first is an MPO and the 
second is an Air Basin. Also, files with same area/calendar year combinations will be over-
written. For example, loading two different template files for Alameda/CY2030 with different 
VMTs at the same time will only generate one emissions output (VMT data from the latter file 
will be used for emissions calculations). 
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Table 5.2-1 Worksheets in EMFAC2025 Format Activity Templates 

*Optional – may or may not be created based on user input. 

**One, not both, will exist. 

The “Settings” worksheet is used for two purposes: to specify the season/month value for the 
desired emissions run, and to indicate whether the template is for SB375 or conformity 
purposes. 

The table below summarizes the effect of selected GUI options in EMFAC2025 on which 
worksheets are generated (see ** in the table above) and how custom activity scaling is 
performed. 

Table 5.2-2 EMFAC2025 Templates: Effect of GUI Options on Worksheets and Scaling 

IMPORTANT!  If the user opts to generate an SB375 template (more details are provided in 
the next section), the Excel template will be ‘hard coded’ as an SB375 template. This is 
because SB375 runs require the Pavley and Advanced Clean Cars standards to be turned off 
in the calculations made for the emissions inventory that will be generated. The Advanced 

Template 
File Format 
Type 

Worksheet Name Description of 
Worksheet Data Fields 

Microsoft 
Excel 

(*.xlsx) 

Settings 
Season/month and 
whether it is a SB375 
template 

Daily_Total_Vmt** Daily total VMT 

Daily_Vmt_By_Veh_Tech** 
Daily VMT by vehicle type 
and fuel 

Hourly_Fraction_Veh_Tech_Speed* 
Hourly speed profile 
calculated using default 
VMT by hour by speed 

User Select GUI Options Scaling Approach (Cannot be Modified) 

VMT Data Type Custom Hourly 
Speed Fractions 

VMT Scaling Result Speed Scaling? 

Total Daily VMT Unchecked Scaling by VMT Total      No 

VMT by Vehicle 
and Fuel Type 

Unchecked Scaling by VMT-Veh Tech No 

Total Daily VMT Checked Scaling by VMT Total Yes 

VMT by Vehicle 
and Fuel Type 

Checked Scaling by VMT-Veh Tech Yes 
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Clean Cars program assumes a different fleet mix and vehicle miles travelled, so output 
produced for SB375 purposes will not match output that was not produced for SB375 
purposes. 

5.2.4 Generating a Custom Activity Template 

The run parameters for generating a custom activity template are summarized in Appendix 
8.4. 

1. Select the “Custom Activity (SG)” Run Type, and then “Generate Custom Activity 
Template” in the pop-up dialog box that appears. 
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2. Click “Start”. The following window will appear: 

 

3. In the Area tab, you can change the area type by clicking where “Sub-Area” appears 
above. 

4. Select one or more Areas. If you hold down either the shift or the control key while 
clicking, you can select multiple areas. Please note that the more areas selected, the 
longer the runtime will be. 

5. Click “Next” or the Time tab 
6. On the Time tab, select one or more calendar years, however, the more years you 

select, the longer runtime will be. 
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7. Select “Season” or “Month” and then specify which Season or Month you would like to 

use. 
8. Click “Next” or the VMT tab. 
9. On the VMT tab, select the VMT data type you would like for inputting the data into 

the template you will generate. 
10. Select “Custom Hourly Speed Fractions” if your own speed profile will be used. 
11. Choose whether or not the template will be for SB375. 
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12. Click the “Generate Template” button. 

 
13. Select where the template will be saved, then click “Save” and the model will start 

generating the template. 
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14. Click “Save” and the model will start generating the template. 

 
 

15. The following window will be shown after the template is generated. 

 

5.2.5 Modifying Custom Activity Templates 

Custom activity templates are generated in a Microsoft Excel format. Users can use Excel to 
edit the data to meet their needs. Before using the activity templates, there are several 
things to know: 

• Standard custom activity templates are in Microsoft Excel worksheet (.xlsx) format. 
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• The worksheet names for either of these types of custom activity template must not be 
changed. These names are used to identify what type of data is present. Worksheets 
with any other names will be ignored. 

• The order and names of columns should not be changed on worksheets and data 
rows should not be deleted. 

• Standard custom activity Templates have a worksheet named “Settings” (below). This 
is primarily used to define the season or month being analyzed and whether the 
custom activity template contains activity for a conformity assessment or an SB375 
assessment. The field indicating the season/month can be changed; the field with the 
SB375 setting cannot be changed. 

 

• For worksheets broken out by vehicle-tech, all vehicle-tech types must be present. If 
you generate a standard custom activity template, all necessary combinations of 
vehicle-tech’s should be provided. 

• If “Custom Hourly Speed Fractions” is selected, the speed fractions should add up to 
one for each hour in the “Hourly_Fraction_Veh_Tech_Speed” tab. 

• The EMFAC default speed profile will always be used for the following vehicle types 
with all fuel types for all regions: 

o PTO 
o UBUS 
o SWCV 

• The EMFAC default speed profile will always be used for drayage trucks with all fuel 
types for Alameda (SF), Los Angeles (MD), Los Angeles (SC), San Bernardino (MD), 
and San Bernardino (SC): 
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o T7 Other Port 
o T7 POAK 
o T7 POLA 

5.2.6 Running EMFAC With a Custom Activity Template 

The run parameters for generating a customized activity inventory are summarized in 
Appendix 8.4. 

1. Return to the Home Screen by selecting “File”, “New” from the menu and select 
“Custom Activity (SG)”. 

2. Select “Load Custom Activity File” and click the “Start” button. 
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3. Click the “Load Custom Activity” button and find the file. You can hold down either 
the shift or control keys during selection to load more than one file at a time.  

 

  
 

* IMPORTANT * 

Files with different area types or seasons or SB375 settings cannot 
be loaded together. Also, files with same area/calendar year 
combinations will be over-written. For example, loading two 

different template files for Alameda/CY2030 with different VMTs 
at the same time will only generate one emissions output (VMT 
data from the latter file will be used for emissions calculations) 
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4. Select the desired file and then click “Open”. Click “Ok”. 

 

 

5. Information about the loaded file is displayed on the window. Make sure the correct 
file has been selected. 
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6. In the output tab, pick the Report Type, choose whether or not to save the output 
data for future use, and change the output location if desired. (See Chapter 7 for a 
description of the Output Files generated by EMFAC2025). 
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7. If the SB375 file was loaded, the output tab will be like the following screen shot. 
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8. Click “Run” to start the calculation 
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9. After the run is completed, a window will show the Output File location and file name. 
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6 Generating Emission Rates 

This section describes how to run EMFAC for a Project-Level (PL) Assessment to generate 
emission rates using project-specific data. This mode generates emission rates based on 
meteorological input (temperature and relative humidity) that users provide. 

EMFAC Project-Level Assessment (EMFAC-PL) is a tool designed to support project-level 
assessments. EMFAC-PL is triggered when EMFAC is run under the Emission Rate mode. 
Using EMFAC-PL, emission rates are estimated based on user- specified, project-specific 
conditions: ambient temperature and relative humidity, vehicle speeds, vehicle classes, 
geographic location, and analysis period (month, season, or annual average). EMFAC-PL 
can provide emission rates by vehicle model year or aggregated ones over model years for 
a vehicle class. It also can provide emission rates by fuel type or emission rates aggregated 
over fuel types. 

This section describes how to run EMFAC in conducting project- level analyses such as a 
PM-hot spot analysis required in transportation conformity determinations. This section 
describes the general steps for using the EMFAC software to generate emission rates for 
project-level analyses and uses five sample scenarios to illustrate the general approach.  

EMFAC-PL outputs are in comma-separated values (CSV) format that can be easily opened 
and edited in MS Excel. 

It is worth noting that unlike the “emission” mode, EMFAC-PL does not produce official GHG 
emissions and only provide estimates of tailpipe CO2 emission rates. Moreover, EMFAC 
“emission” mode has added ammonia emissions, EMFAC-PL does not output ammonia 
emission rate, which can be easily back calculated based total emissions and VMT from the 
“emission” mode.  

6.1 Project-Level Analysis 

6.1.1 Approach 

The figure below shows the general steps for using EMFAC-PL and points to the subsequent 
sections of this document that provide additional details. 

In general, to use EMFAC-PL for a project-level analysis, users need to: 

• Determine the number of unique run scenarios based on the scope and resolution of 
the traffic activity data (a detailed discussion is provided in Section 6.1.2), 

• Gather project-specific input (Section 6.3), 
• Select desired aggregation scale, and 
• Execute the PL run and look up emission rate output for contents of interest (Section  

6.5) 
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6.1.2 Determine the Number of EMFAC Runs 

To use the EMFAC-PL efficiently, users need to first determine the number of runs needed 
that can sufficiently describe activity variation in a project. A single EMFAC-PL run allows 
users to select multiple areas or sub-areas, calendar years, vehicles, speed bins, and 
meteorology conditions. However, when a project involves multiple areas or sub-areas or 
includes multiple calendar years, it is likely that other inputs of interests, such as link speed 
or meteorology conditions may be different in each area or sub-area and may also vary by 
calendar year. Under these circumstances, users are recommended to run multiple 
scenarios, with each scenario characterizing a unique combination of fleet, speed bin, and 
meteorology conditions for one area and calendar year. Compared to a single run with 
multiple areas and calendar years, the multi-run approach can eliminate unnecessary model 
runs, and reduces users’ burden of having to filter out the desired results from massive 
outputs. 
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EMFAC-PL allows users to model one season (summer, winter, or annual average) or one 
month in one run. Users who are interested in multiple seasons or month-to-month 
variations need to obtain results from multiple runs. 

EMFAC emission rates are not specified by the hour of day, or day of a month. However, the 
main factors causing the temporal variation of emission rates for a particular vehicle type are 
meteorological conditions, that is, temperature and relative humidity. These meteorology 
conditions are used directly to define emission rates and can be specified by the hour of 
day or the day of month. EMFAC2025-PL accepts up to 24 sets of user-specified 
temperature and relative humidity combinations as input in one run. Therefore, users who 
are interested in temporal variation can prepare a list of unique temperature and humidity 
combinations under study. For example, in a typical project-level analysis where activities 
are specified by four time periods (morning peak, midday, evening peak, and overnight), 
users should collect the temperature and relative humidity in each period and input the four 
pairs of values in one model run. If there are more than 24 sets of meteorology conditions of 
interest, multiple runs are needed. 

6.2 Setting Up a Project-Level Assessment of Emissions Rates Run 

The run parameters for generating emissions rates are summarized in Appendix 8.5. 

1. Start the model or clicking “New” in the File menu. 
2. Select Emission Rates as the Run Mode, and Project-Level Assessment (PL) as the Run 

Type and click “Start”. 
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• This takes the user to a window with four tabs; the Area tab, the Time 
tab, the Vehicles tab, the Meteorology tab, and the Output tab. Each 
tab presents options for the user to customize the PL run. 

6.3 Develop Scenario Inputs 

6.3.1 Geographic Area Tab 

Upon starting a PL run, users first need to select the geographic area where the project is 
located. There are six region types: Statewide, Air Basin, Air District, MPO, County, and Sub- 
Area (GAI). Under each of these types, users can select one or multiple regions (hold down 
shift key and click for multiple selections). 

Regardless of which of the six region types is chosen, EMFAC2025-PL always generates 
emission rates at the GAI level and does not provide area-wide average emission rates for 
any geographic scale higher than GAI. When a project-level analysis involves more than one 
GAI, users are required to provide project-specific activities for each GAI, separately. 

For instance, Los Angeles County consists of two GAIs: the part located in the Mojave Desert 
Air Basin and the part located in the South Coast Air Basin. If a project is located in the port 
of Los Angeles, users only need to choose “Sub-Area” and pick “Los Angeles (SC)” to 
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generate the emission rates. If a project is located in both GAIs of the Los Angeles County, 
users should choose “County” and pick “Los Angeles”. Emission rates will be generated 
separately for the two parts of the county and users should prepare the project activities in 
each GAI separately to match the relevant emission rates. 

The GAI selection matters in that, 1) different regions have different I/M (smog check) 
programs, which affect exhaust emission rates; 2) different regions designate the same 
month to either summer or winter season differently, and HDT idle emission rates vary by 
season; 3) different regions have different Reid Vapor Pressure (RVP) schedules and RVP 
affects evaporative emission rates; 4) exhaust emission rates are corrected for altitude in El 
Dorado (LT) and Placer (LT) ; and 5) evaporative emission rates are corrected for altitude in 
all GAIs. 

 

 

6.3.2 Time Tab 

• Calendar Year 
o EMFAC2025 is designed to analyze calendar years from 2000 to 2050. It allows 

users to select multiple calendar years in a single run. However, if other inputs, 
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such as project travel speed, temperature, or humidity, changes from one year to 
another, users should consider separate annual runs.  

• Season or Month 
o EMFAC2025 can only model one season (summer planning episode, winter 

planning episode, or annual) or one month in a single run. Season or month 
selection affects emission rates because seasonal fuel composition differences 
lead to a difference in fuel Reid Vapor Pressure (RVP), and RVP affects evaporative 
emissions. In addition, idle emissions rates also vary by season. 

 

 

6.3.3 Vehicles Tab 

• EMFAC2025-PL provides output in one of six vehicle categorization schemes: 
EMFAC202Y, EMFAC202X, EMFAC2011, EMFAC2007, Truck1 - Truck2 - NonTruck, 
or Truck - NonTruck. Vehicle classifications based on these four categorization 
schemes are presented in Appendix 8.3. 

• The vehicle classes are listed by the vehicle categorization schemes. Under each 
scheme, users may choose one or more vehicle classes, and emission rates will be 
generated only for the selected vehicle classes. For example, if users select the 
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EMFAC2007 scheme, then they may select from the 13 vehicle classes defined in 
EMFAC2007: LDA, LDT1, LDT2, MDV, MCY, LHD1, LHD2, MHDT, HHDT, MH, OBUS, 
SBUS, and UBUS. 

• Emission rates will be aggregated to the scale of the chosen categorization scheme. 
For example, if users choose “Truck - NonTruck”, and select both “Truck” and 
“NonTruck” entries, the output will include aggregated emission rates for “Truck” and 
“Non-Truck”. 

• We suggest that users choose vehicle categorization closest to the characteristics of 
their project-level activity data. For instance, if for a project the activities are specified 
for MHDT and HHDT, which are EMFAC2007 classes, then users should choose the 
EMFAC2007 categorization scheme and select these two vehicle classes. The data 
can be output in either the “By Model Year” or the “Aggregated” format. 

o The “By Model Year” option is for projects in which the activity data by model 
year are used. 

o The “Aggregated” option is for projects in which only the aggregated total 
activity, but not the activity by model year, is used. 

• The user can choose to output the data “By Fuel” (for output by each fuel type) or 
“Aggregated” (for aggregated output only). 

• Special attention should be given to modeling bus fleets. Starting with EMFAC2011, 
additional bus categories were added to the vehicle class definitions 

o “Motor Coach” are heavy diesel interstate tour buses regulated under the 
Truck and Bus regulation. 

o “OBUS” now refers to gasoline, diesel and natural gas buses that are not 
school buses, urban buses, or motor coaches. Rental shuttles and church buses 
fall in this category. Previously diesel and natural “OBUS” categories were 
referred to as “All Other Buses.” 

o “UBUS” refers to urban transit buses with all fuel types operating by transit 
agencies. 

• Speed Bin 
o In EMFAC2025-PL, speeds are characterized in the form of speed bins at 5 

mph intervals. Therefore, users are required to provide project-specific VMT 
according to these speed bins. At least one speed bin needs to be selected. 
For projects assessed at a single speed, users can pick an appropriate speed 
bin as suggested below. For projects with a range of speeds, users need to 
distribute the VMT into each speed bin to match the corresponding emission 
rates. 

o The speed bin is defined by the upper range of each bin. For example, the “5 
mph” speed bin refers to 0 - 5 mph, the “10 mph” speed bin refers to 5 - 10 
mph, and so on. The speed correction factors for a speed bin are computed 
using the midpoint value of the speed range. 
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Table 6.3-1 Speed Bin Definition 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*For HD vehicles, speed correction factors for speed bin 5 are computed at the speed of 5 mph. 

Therefore, if a project accesses link speed at 50 miles per hour, users are suggested to use 
the 50 mph speed bin for a rough estimate, or to compute the weighted average of 
emission rates at 50 mph bin and 55 mph bin for a more accurate estimate. 

That is, 

𝐸𝐸𝐸𝐸𝐸𝐸𝐸𝐸𝑢𝑢𝑢𝑢𝑢𝑢𝑢𝑢 = 𝐸𝐸𝐸𝐸𝐸𝐸𝐸𝐸𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑙 𝑏𝑏𝑏𝑏𝑏𝑏 × �
𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑢𝑢𝑢𝑢𝑢𝑢𝑢𝑢𝑢𝑢 𝑏𝑏𝑏𝑏𝑏𝑏 − 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑢𝑢𝑢𝑢𝑢𝑢𝑢𝑢

5 �

+ 𝐸𝐸𝐸𝐸𝐸𝐸𝐸𝐸𝑢𝑢𝑢𝑢𝑢𝑢𝑢𝑢𝑢𝑢 𝑏𝑏𝑏𝑏𝑏𝑏 × �
𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑢𝑢𝑢𝑢𝑢𝑢𝑢𝑢 − 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑙 𝑏𝑏𝑏𝑏𝑏𝑏

5 � 

Where the Speedupper bin refers to the midpoint speed for the upper speed bin used in 
the calculation, and the Speedlower bin refers to the midpoint speed for the lower speed 
bin used in the calculation. In the above example, the upper bin is 55 mph, and the 
lower bin is 50 mph,  therefore the Speedupper bin is 52.5 mph and the Speedlower bin is 
47.5 mph, that is, 

𝐸𝐸𝐸𝐸𝐸𝐸𝐸𝐸50 = 𝐸𝐸𝐸𝐸𝐸𝐸𝐸𝐸50 𝑚𝑚𝑚𝑚ℎ 𝑏𝑏𝑏𝑏𝑏𝑏 × �
52.5 − 50

5 � + 𝐸𝐸𝐸𝐸𝐸𝐸𝐸𝐸55 𝑚𝑚𝑚𝑚ℎ 𝑏𝑏𝑏𝑏𝑏𝑏 × �
50 − 47.5

5 �
= 0.5 × 𝐸𝐸𝐸𝐸𝐸𝐸𝐸𝐸50 𝑚𝑚𝑚𝑚ℎ 𝑏𝑏𝑏𝑏𝑏𝑏 + 0.5 × 𝐸𝐸𝐸𝐸𝐸𝐸𝐸𝐸55 𝑚𝑚𝑚𝑚ℎ 𝑏𝑏𝑏𝑏𝑏𝑏 

Speed Bin* Speed Value to compute SCF Definition 

5 2.5* Speed <= 5 
10 7.5 5 < Speed <= 10 
15 12.5 10 < Speed <= 15 
20 17.5 15 < Speed <= 20 
25 22.5 20 < Speed <= 25 
30 27.5 25 < Speed <= 30 
35 32.5 30 < Speed <= 35 
40 37.5 35 < Speed <= 40 
45 42.5 40 < Speed <= 45 
50 47.5 45 < Speed <= 50 
55 52.5 50 < Speed <= 55 
60 57.5 55 < Speed <= 60 
65 62.5 60 < Speed <= 65 
70 67.5 65 < Speed <= 70 
75 72.5 70 < Speed <= 75 
80 77.5 75 < Speed <= 80 
85 82.5 80 < Speed <= 85 
90 87.5 Speed > 85 
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6.3.4 Meteorology Tab 

• PL Runs require users to meteorological conditions 
• Each pair of temperature (in Fahrenheit) and relative humidity (in percentage without 

% sign) must be provided in each row. See the example in the following screen shot. 
o The number of pairs of temperature and relative humidity will be limited to 24 

for each PL run; that is one pair for each hour of the day 
o The user may either type the temperatures and relative humidity pairs into the 

meteorology box or copy the data from an Excel File. 
• The allowed input temperature range is from -20ºF to 120ºF and the allowed input 

relative humidity range is from 0% to 100%. 
o These input ranges are broader than the corresponding default ranges, used 

in EMFAC2025.  
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6.3.5 Output Tab 

• The Pollutants group box allows the user to choose the Pollutants for which data are to 
be included in the output. 

 

 

• The Output Options group box allows users choose whether to split the output by 
GAI and Calendar Year and to specify a different directory to hold the output files by 
clicking the “Change Directory” button. 

 

IMPORTANT – CO2 emission rates from PL tool are tailpipe CO2 and are not 

the same as the “complete combustion CO2” under the “emission” mode. 
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56 

 

 Table 6.3-2 Input Data User Options and Default Assumptions 

1In EMFAC2025 default California meteorology data, the temperature range is (16.7F, 106.9F) and 
the relative humidity range is (13.4%, 100%) 

6.4 Starting the Project-Level Model Run 

• Click “Run EMFAC”, in the Run Menu, or the “Run” button at the lower right 
• corner of the Output tab to start the model run. 
• Save the “Run Specification” (as _ers.toml file) for future use after all run parameters 

have been determined. Click “Save” in the File menu or click “OK” in the pop-up 
window after the run button is clicked to save the _ers.toml file. 

 

Input Data User's Option or Default 
Geographic Area - 
-Geographic Scope Multiple scales, multiple selections 
-Aggregation Scale Default: by sub-area 
Calendar Year Multiple selections 
Vehicles - 
-Vehicle class aggregation Multiple scales, multiple selections 
-Fuel type aggregation Optional 
-Model year aggregation Optional 
Pollutants Multiple selections 
Temperature Any integer, up to 24 entries 
Relative humidity Any integer, up to 24 entries 
RVP Default only 
Speed Multiple selections of speed bins 
Pop by vehicle/fuel/age Default data used for aggregated emission rates 
VMT by vehicle/fuel/age Default data used for aggregated emission rates 
Trips by vehicle/fuel/hour Default data used for aggregated emission rates 

VMT hourly distribution 
Not used in PL. Users prepare this data to conduct 
hourly analysis. 

Speed Fractions by hour 
Not used in PL. Users prepare this data to conduct 
hourly analysis. 
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• The model run can be stopped by clicking “Cancel” in the EMFAC2025 Window. 
• The pop-up window provides the names and locations of the output files generated 

after the run has finished. 

6.5 Use Emission Rate Outputs 

Upon completion of a model run, emission rate outputs are generated in one or more 
CSV files. The name of the CSV files consists of a scenario name and a time stamp. As 
shown in Table 6.5-1, the CSV file contains emission rates by calendar year, season or 
month, sub- area, selected vehicle classification, temperature, relative humidity, 
process, speed bin or soak time, and pollutants. 
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Table 6.5-1 Summary of Columns in CSV output Files 

Column Name Description 
calendar_year Calendar Year between 2000 -2050 
season_month Annual, summer, winter, or one of the twelve months 
sub_area (GAI) Sub Area as defined in Appendix 8.2 

vehicle_class 
Vehicle class selected based on user-selected 
categorization. Refer to Appendix 8.3 

fuel* Gasoline, diesel, or other fuel types 
model_year* Model years 
temperature Temperature in Fahrenheit 
relative_humidity Relative humidity in percentage 
process Emission process 

speed_time 

For running exhaust (RUNEX), the “speed_time” column 
provides the speed bin ranging from 5 mph to 90 mph. 
For the start process, this field provides the soak time 
prior to vehicle starting in minutes, ranging from 5 
minutes to 720 minutes. For other processes, where 
emissions rates do not depend on speed bin or soak time, 
this field is blank. 

emission_rate Emissions per unit of activity 

*These fields depend on user’s choice 

In EMFAC2025-PL, emission rates are always specified by process. A project-level 
analysis should combine these emission rates with the appropriate activities. Table 
6.5-2 shows the emission rate units and associated activity for each process 

 

Table 6.5-2 EMFAC2025-PL Emission Rate and Activity Units by Process 

Process 
Name 

Process type Unit Associated Activity 

RUNEX Running Exhaust gram/veh-mile VMT by speed bin 

IDLEX Idle Exhaust gram/veh-idle hour Number of Idle Hours 

STREX Start Exhaust gram/veh-start Number of starts 

HOTSOAK Hot Soak Evaporative gram/veh-start Number of starts 

RUNLOSS Running Loss Evaporative gram/veh-hour Running hours 

DIURNAL Diurnal Evaporative gram/veh-hour Cold soak hours 

PMBW Brake Wear gram/veh-mile VMT by speed bin 

PMTW Tire Wear gram/veh-mile VMT over all speed bin 



 

 

6.5.1 RUNEX: Running Exhaust Emission Rates 

Running Exhaust (RUNEX) emissions refer to the emissions that come out of the vehicle 
tailpipe while the vehicle is traveling on the road, including at speed and idling that occurs 
as part of normal driving, such as at intersections. RUNEX emission rates in a PL output are 
specified by temperature, relative humidity, and speed bin. 

6.5.2 IDLEX: Idle Exhaust Emission Rates 

Idle Exhaust (IDLEX) emissions refer to the emissions during extended idling events (i.e., a 
continuous segment of vehicle activity that meets three criteria: all instantaneous vehicle 
speeds being lower than 5 mph, the total distance of less than 1 mile, and the total duration 
of more than 5 minutes) by heavy duty trucks. Extended idle may occur during loading or 
unloading goods, or to power accessories. Idle exhaust is calculated only for heavy-duty 
trucks. For light duty vehicles, the idle events during normal vehicle operation are already 
accounted for, i.e. RUNEX emission rates are based on driving cycles that include normal 
idling events. IDLEX emission rates do not vary by temperature and humidity and are not 
related to speed bins. 

In EMFAC2025-PL, idle emission rates represent emissions from the main engine only; 
emissions from auxiliary power systems (APS) are excluded. The reason for this is that an APS 
is operated independently from the truck’s main engine and behaves very differently. For 
users interested in project-level APS emissions, APS emission rates are provided in Appendix 
8.8. Note that, in EMFAC2025 (not PL), the emission inventory estimation procedure for APS 
emissions is to include them as part of total HHDT idle emissions rather than as an 
independent process. 

Idle emission rates are in units of grams per vehicle idle hour. To estimate idle emissions from 
an HD fleet, idle emission rates should be coupled with the total number of hours that the 
HD fleets engage in idling in the analysis time frame. 

6.5.3 STREX: Start Exhaust Emission Rates 

Start Exhaust (STREX) emissions are the excess emissions that occur when a vehicle is starting 
because the emissions-control equipment has not yet reached its optimal operating 
temperature. Start exhaust emissions are independent of running exhaust emissions. The 
magnitude of start emissions is dependent on the soak time, that is, the duration between 
the last engine-off event and the current engine-on event. In general, the longer the soak 
time is, the higher the STREX emissions. EMFAC2025-PL estimates start emission rates using 
18 different soak time bins, ranging from 5 minutes to 720 minutes. Starts after the vehicle 
engine has been shut-off for more than 720 minutes (12 hours) are considered cold starts 
and are assumed to have the same STREX emission rates with soak time of 720 minutes. 



 

 

To estimate start emissions for a project, users need to prepare the number of starts by soak 
time bin. This includes the cases where a project has a known typical soak time (or a known 
soak time distribution). 

6.5.4 Evaporative Emission Rates 

In EMFAC2025-PL, evaporative emissions are produced in three modes of vehicle 
operations: hot soak, running loss, and diurnal. Evaporative emissions are generated as 
gasoline fuels evaporate and escape from the vehicle’s fuel system. 

Hot soak emissions are the hydrocarbon (HC) emissions that are emitted from a vehicle 
while the engine is still hot after the vehicle stopped operating until the fuel tank 
temperature cools down to a non-operation level. Hot soak emission rates are in the unit of 
gram per vehicle start and should be combined with the number of starts to estimate total 
emissions. 

Running loss emissions are the HC emissions that are emitted while the vehicle engine is on. 
Running loss emission rates in EMFAC2025-PL are in the unit of gram per running hour, 
which is evaporative emission per hour that the vehicle is operating. To estimate total 
running loss emissions, the emission rates should be coupled with the total number of 
vehicle operating hours within the analysis period. 

Diurnal emissions are the HC emissions from a sitting vehicle while the ambient 
temperature changes. The emissions occur when the amount of fuel vapors generated in 
the fuel tank exceeds the capacity of the carbon canister and they are vented out to the 
atmosphere. 

Diurnal emission rates are in the unit of gram per cold soak hours. 

Evaporative emission rates for MHDT, HHDT, SBUS, and OBUS categories only represent the 
gasoline sub-fleets. Users are advised to conduct the analysis by fuel type if they are 
interested in evaporative emissions 

  



 

 

7 Description of Output 

By default, the output files are saved in the “output” folder under the EMFAC installation 
directory. Users can specify another folder to hold these files. Output file names, which 
are generated automatically, start with the name of “_ers.toml” files or the names of the 
custom activity input files, followed by output type and a timestamp suffix. 

For example, the default names for the output files for the default activity emissions run 
specification file “Default_AlamedaSF_2012_Annual_ers.toml” will be: 

• “Default_AlamedaSF_2012_Annual_emission_20241208193758.csv” for 
the emissions inventory file; 

• “Default_AlamedaSF_2012_Annual_ghg_20241208193758.csv” for the 
ghg emissions inventory file; 

• “Default_AlamedaSF_2012_Annual_population_20241208193758.csv” for 
the vehicle population file; 

• “Default_AlamedaSF_2012_Annual_trips_20241208193758.csv” for the 
trips file; 

• “Default_AlamedaSF_2012_Annual_vmt_20241208193758.csv” for the 
vehicle miles traveled file. 

• “Default_AlamedaSF_2012_Annual_energycons_20241208193758.csv” for 
the energy consumption file. 

The default names for the output files for the custom activity emissions input file 
“Custom_KernSJV_2020_Annual.xlsx” will be: 

• “Custom_KernSJV_2020_Annual_ emission_20241208231949.csv” for 
the emissions inventory file; 

• “Custom_KernSJV_2020_Annual_ population_20241208231949.csv” for 
the vehicle population file; 

• “Custom_KernSJV_2020_Annual_ trips_20241208231949.csv” for the trips file; 
• “Custom_KernSJV_2020_Annual_ vmt_20241208231949.csv” for the 

vehicle miles traveled file; 
•  “Custom_KernSJV_2020_Annual_planning_20241208231949.xlsx” for 

the planning inventory file; 
• “Custom_KernSJV_2020_Annual_ctf_20241208231949.csv” for the 

CEIDARS Transaction Format (CTF) file. 

The default names for the output files for the run specification file for the emission rates 
input file “PL_AlamedaSF_2012_Annual_ers.toml” will be: 

• “PL_AlamedaSF_2012_Annual_2024120812621.csv” for the emissions rate file 



 

 

7.1 CSV (Comma Separated Values) 

The standard output format from EMFAC2025 is CSV, the same as previous versions of 
EMFAC. CSV is a common, relatively simple file format that is widely used by consumers, 
businesses, and scientific applications. 

For emissions runs, both EMFAC default and custom activity type, the model may output up 
to four CSV files per Sub-Area and Calendar Year. Typically, emissions data, VMT, energy 
consumption, trips, and vehicle population data are reported in separate output files. 

Please note that the speed_time column in the emissions rates report from a PL run contains 
different values for different processes. It indicates speed bin for running exhaust and it 
indicates the time, in minutes, that the vehicle has been sitting prior to starting for start 
emissions. 

 

Table 7.1-1 provides descriptions of the columns in the emissions, activity, and emission 
rates CSV output files. Table 7.1-2 lists the emissions processes in the emissions rates output 
files. 

As stated in Section 4.1, in order to manage the size of the output files, emissions and 
emission rates that are equal to zero are not included in the output files. Therefore, in 
instances when data is missing in the output file, the user can interpret them as zero 
emissions or an emission rate of zero. 



 

 

Table 7.1-1 Summary of Columns in CSV Output Files 

Table 7.1-2 Emissions Processes in Emissions Rates Files 

 

Column Name Description 
calendar_year Calendar Year between 2000 -2050 

season_month 
Annual, summer, winter or one of the twelve 
months 

sub_area (GAI) Sub Area as defined in Appendix 8.2 
vehicle_class Vehicle class as defined in Appendix 8.3 
fuel Gasoline, PHEV, diesel, natural gas, and electric 
model_year Model year 
hour One of the 24 hour 
speed Speed bin from 5 to 90 with 5 incremental 
process Emission process 
cat_ncat With or without catalytic converter 
pollutant Pollutants 
emission Amount of emissions 
vmt Vehicle-miles traveled 
trips Number of trips 
population Vehicle population 
temperature Temperature in Fahrenheit 
relative_humidity Relative humidity in percentage 

speed_time 

For running exhaust (RUNEX), the “speed_time” 
column provides the speed bin ranging from 5 
mph to 90 mph. For the start process, this field 
provides the soak time prior to vehicle starting 
in minutes, ranging from 5 minutes to 720 
minutes. For other processes, where emissions 
rates do not depend on speed bin or soak time, 
this field is blank. 

emission_rate Emissions per unit of activity 

Emission Process Description 
RUNEX Running Exhaust 
IDLEX Idle Exhaust 
STREX Start Exhaust 
RUNLOSS Running Loss Evaporative 
HOTSOAK Hot Soak Evaporative 
DIURN Diurnal Evaporative 
PMTW PM Tire wear 
PMBW PM Brake wear 



 

 

7.2 Planning Inventory Report 

The Planning Inventory Report generated from the Custom Activity type is a Microsoft Excel 
Workbook that contains emissions and activities which are summed by area, calendar year, 
and vehicle-tech type. It provides a column for every pollutant and process, with sub-total 
columns at the appropriate places. It provides a summary worksheet for a given area and 
another worksheet entitled “By Sub-Area” in which the data are broken out by the sub-areas 
within the area specified by the user (if selected).If a run is only for a single sub-area, or if an 
area only has one sub-area (such as the Lake County Air Basin), only one data worksheet will 
be produced. This report includes a “Read_me” tab and a “Glossary tab” which provides 
information on the report type, the date and time the report was generated, and an 
explanation of the columns. 

IMPORTANT!  The Planning Inventory Report generated by the Custom Activity type does 
not correspond to official GHG emissions. However, the EMFAC2025 default runs employ a 
methodology consistent with CARB’s official GHG inventory estimation. 

7.3 SB375 Report 

The SB375 report generated from the Custom Activity type is a Microsoft Excel Workbook 
that is a sub-set of the Planning Inventory Report described above. It is limited to four light-
duty vehicle types (LDA, LDT1, LDT2, and MDV), CO2 emissions, and related activity. The 
only vehicle-tech types included in this SB375 report are: 

Custom Activity SB375 Vehicle Types 

LDA 

DSL 

LDT2 

DSL 

BEV BEV 

GAS GAS 

PHE PHE 

LDT1 

DSL 

MDV 

DSL 

BEV BEV 

GAS GAS 

PHE PHE 

IMPORTANT! – Note again that, for SB375 analyses, ACC/Pavley are deactivated. Also, 
because the ACC regulation has certain assumptions about vehicle usage built into it, 
default data in custom activity templates produced for conformity assessments will not 
match the default data in templates for SB375 assessments (differences will result and affect 
any comparisons between the two). As a result, CO2 emissions in an SB375 report will not 
equal CO2 emissions from a standard planning inventory report. 

7.4 CTF Report 

The CEIDARS Transaction Format (CTF) generated from the Custom Activity type is a report 
used internally by CARB to import emissions inventory data into an internal emissions 



 

 

inventory database and forecasting system. The area and sub-area fields, produced by 
EMFAC, are replaced with the County-Air Basin-District coding system, and the Emissions 
Inventory Code (EIC) system replaces the vehicle-tech type and the processes. Appendix 8.6 
describes the fields in a CTF file. 

 

 

 
 

  



 

 

8 Appendices  

8.1 Summary of Run Parameters for Generating Default Emissions 
Inventory 

  

Tab Run Parameters Description 

Area 
Area Type One of the area types can be picked. 

Area One or more areas can be selected for one run. 

Time 

Calendar Year 
Between 2000 and 2050. One or more calendar years can be 
selected for one run. 

Season/Month 
One of the three seasons (annual, summer, winter) or one of the 
12 months can be selected for one run. 

Day or Hour 
Aggregation 

Output emissions by day or by hour. 

Vehicle s 

Vehicle Class 
type 

Output by EMFAC2025, EMFAC2021, EMFAC2011, or 
EMFAC2007 vehicle class. 

Vehicle Class One or more vehicle classes can be picked for one run. 

Model Year 
Aggregated or by model year in output. One or more model 
years can be selected if by model year is picked. 

Speed Aggregated or by speed in output. 

Output 

Pollutants Pollutants in output. 

Activities 
Pick one or more of the activities (VMT, vehicle population, 
trips, or energy consumption) to be included in output files. 

Output by 
process 

Whether to output by process. 

Output by 
Cat/NonCat 

Whether to output by Cat/NonCat. 

Save data for 
future use 

Users can get results faster in the future if data from previous 
runs are saved and used. 

     Output Options 
Whether to split output by Sub Area & Calendar Year 

Where to save output files 



 

 

8.2 Definition of Areas 

Sub-Area County 
Name 

Air Basin 
Name Air District Name MPO MPO Name 

Alameda (SF) Alameda 
San 
Francisco 
Bay Area 

Bay Area AQMD MTC 
Metropolitan Transportation 
Commission 

Alpine (GBV) Alpine 
Great Basin 
Valleys 

Great Basin Unified 
APCD 

  

Amador (MC) Amador 
Mountain 
Counties 

Amador County 
APCD 

  

Butte (SV) Butte 
Sacramento 
Valley 

Butte County AQMD BCAG 
Butte County Association of 
Governments 

Calaveras (MC) Calaveras 
Mountain 
Counties 

Calaveras County 
APCD 

  

Colusa (SV) Colusa 
Sacramento 
Valley 

Colusa County 
APCD 

  

Contra Costa 
(SF) 

Contra 
Costa 

San 
Francisco 
Bay Area 

Bay Area AQMD MTC 
Metropolitan Transportation 
Commission 

Del Norte (NC) Del Norte North Coast 
North Coast Unified 
AQMD 

  

El Dorado (LT) El Dorado Lake Tahoe 
El Dorado County 
AQMD 

TMPO 
Tahoe Metropolitan Planning 
Organization 

El Dorado (MC) El Dorado 
Mountain 
Counties 

El Dorado County 
AQMD 

SACOG 
Sacramento Area Council of 
Governments 

Fresno (SJV) Fresno 
San Joaquin 
Valley 

San Joaquin Valley 
APCD 

COFCG 
Fresno Council of 
Governements 

Glenn (SV) Glenn 
Sacramento 
Valley 

Glenn County APCD   

Humboldt (NC) Humboldt North Coast 
North Coast Unified 
AQMD 

  

Imperial (SS) Imperial Salton Sea 
Imperial County 
APCD 

SCAG 
Southern California 
Association of Governments 

Inyo (GBV) Inyo 
Great Basin 
Valleys 

Great Basin Unified 
APCD 

  

Kern (MD) Kern 
Mojave 
Desert 

Eastern Kern APCD KCOG Kern Council of Governments 

Kern (SJV) Kern 
San Joaquin 
Valley 

San Joaquin Valley 
APCD 

KCOG Kern Council of Governments 

Kings (SJV) Kings 
San Joaquin 
Valley 

San Joaquin Valley 
APCD 

KCAG Kern Council of Governments 

Lake (LC) Lake Lake County Lake County AQMD   

Lassen (NEP) Lassen 
Northeast 
Plateau 

Lassen County 
APCD 

  

Los Angeles 
(MD) 

Los 
Angeles 

Mojave 
Desert 

Antelope Valley 
AQMD 

SCAG 
Southern California 
Association of Governments 

Los Angeles 
(SC) 

Los 
Angeles 

South Coast South Coast AQMD SCAG 
Southern California 
Association of Governments 

Madera (SJV) Madera 
San Joaquin 
Valley 

San Joaquin Valley 
APCD 

MCTC 
Madera County 
Transportation Commission 



 

 

Sub-Area County 
Name 

Air Basin 
Name Air District Name MPO MPO Name 

Marin (SF) Marin 
San 
Francisco 
Bay Area 

Bay Area AQMD MTC 
Metropolitan Transportation 
Commission 

Mariposa (MC) Mariposa 
Mountain 
Counties 

Mariposa County 
APCD 

  

Mendocino 
(NC) 

Mendocino North Coast 
Mendocino County 
AQMD 

  

Merced (SJV) Merced 
San Joaquin 
Valley 

San Joaquin Valley 
APCD 

MCAG 
Merced County Association 
of Governments 

Modoc (NEP) Modoc 
Northeast 
Plateau 

Modoc County 
APCD 

  

Mono (GBV) Mono 
Great Basin 
Valleys 

Great Basin Unified 
APCD 

  

Monterey (NCC) Monterey 
North 
Central 
Coast 

Monterey Bay Air 
Resources District 

AMBAG 
Association of Montery Bay 
Governments 

Napa (SF) Napa 
San 
Francisco 
Bay Area 

Bay Area AQMD MTC 
Metropolitan Transportation 
Commission 

Nevada (MC) Nevada 
Mountain 
Counties 

Northern Sierra 
AQMD 

  

Orange (SC) Orange South Coast South Coast AQMD SCAG 
Southern California 
Association of Governments 

Placer (LT) Placer Lake Tahoe Placer County APCD TMPO 
Tahoe Metropolitan Planning 
Organization 

Placer (MC) Placer 
Mountain 
Counties 

Placer County APCD SACOG 
Sacramento Area Council of 
Governments 

Placer (SV) Placer 
Sacramento 
Valley 

Placer County APCD SACOG 
Sacramento Area Council of 
Governments 

Plumas (MC) Plumas 
Mountain 
Counties 

Northern Sierra 
AQMD 

  

Riverside 
(MD/MDAQMD) 

Riverside 
Mojave 
Desert 

Mojave Desert 
AQMD 

SCAG 
Southern California 
Association of Governments 

Riverside 
(MD/SCAQMD) 

Riverside 
Mojave 
Desert 

South Coast AQMD SCAG 
Southern California 
Association of Governments 

Riverside (SC) Riverside South Coast South Coast AQMD SCAG 
Southern California 
Association of Governments 

Riverside (SS) Riverside Salton Sea South Coast AQMD SCAG 
Southern California 
Association of Governments 

Sacramento 
(SV) 

Sacramento 
Sacramento 
Valley 

Sacramento 
Metropolitan AQMD 

SACOG 
Sacramento Area Council of 
Governments 

San Benito 
(NCC) 

San Benito 
North 
Central 
Coast 

Monterey Bay Air 
Resources District 

AMBAG 
Association of Montery Bay 
Governments 

San Bernardino 
(MD) 

San 
Bernardino 

Mojave 
Desert 

Mojave Desert 
AQMD 

SCAG 
Southern California 
Association of Governments 

San Bernardino 
(SC) 

San 
Bernardino 

South Coast South Coast AQMD SCAG 
Southern California 
Association of Governments 

San Diego (SD) San Diego San Diego 
San Diego County 
APCD 

SANDAG 
San Diego Association of 
Governments 



 

 

Sub-Area County 
Name 

Air Basin 
Name Air District Name MPO MPO Name 

San Francisco 
(SF) 

San 
Francisco 

San 
Francisco 
Bay Area 

Bay Area AQMD MTC 
Metropolitan Transportation 
Commission 

San Joaquin 
(SJV) 

San 
Joaquin 

San Joaquin 
Valley 

San Joaquin Valley 
APCD 

SJCOG 
San Joaquin Council of 
Governments 

San Luis Obispo 
(SCC) 

San Luis 
Obispo 

South 
Central 
Coast 

San Luis Obispo 
County APCD 

SLOCOG 
San Luis Obispo Council of 
Governments 

San Mateo (SF) San Mateo 
San 
Francisco 
Bay Area 

Bay Area AQMD MTC 
Metropolitan Transportation 
Commission 

Santa Barbara 
(SCC) 

Santa 
Barbara 

South 
Central 
Coast 

Santa Barbara 
County APCD 

SBCAG 
Santa Barbara County 
Association of Governments 

Santa Clara (SF) Santa Clara 
San 
Francisco 
Bay Area 

Bay Area AQMD MTC 
Metropolitant Transportation 
Commission 

Santa Cruz 
(NCC) 

Santa Cruz 
North 
Central 
Coast 

Monterey Bay Air 
Resources District 

AMBAG 
Association of Monterey Bay 
Governments 

Shasta (SV) Shasta 
Sacramento 
Valley 

Shasta County 
AQMD 

SCRTPA 
Shasta Regional 
Transportation Agency 

Sierra (MC) Sierra 
Mountain 
Counties 

Northern Sierra 
AQMD 

  

Siskiyou (NEP) Siskiyou 
Northeast 
Plateau 

Siskiyou County 
APCD 

  

Solano (SF) Solano 
San 
Francisco 
Bay Area 

Bay Area AQMD MTC 
Metropolitan Transportation 
Commission 

Solano (SV) Solano 
Sacramento 
Valley 

Yolo-Solano AQMD MTC 
Metropolitan Transportation 
Commission 

Sonoma (NC) Sonoma North Coast 
Northern Sonoma 
County APCD 

MTC 
Metropolitan Transportation 
Commission 

Sonoma (SF) Sonoma 
San 
Francisco 
Bay Area 

Bay Area AQMD MTC 
Metropolitan Transportation 
Commission 

Stanislaus (SJV) Stanislaus 
San Joaquin 
Valley 

San Joaquin Valley 
APCD 

StanCOG 
Stanislaus Council of 
Governments 

Sutter (SV) Sutter 
Sacramento 
Valley 

Feather River AQMD SACOG 
Sacramento Area Council of 
Governments 

Tehama (SV) Tehama 
Sacramento 
Valley 

Tehama County 
APCD 

  

Trinity (NC) Trinity North Coast 
North Coast Unified 
AQMD 

  

Tulare (SJV) Tulare 
San Joaquin 
Valley 

San Joaquin Valley 
APCD 

TCAG 
Tulare County Association of 
Governments 

Tuolumne (MC) Tuolumne 
Mountain 
Counties 

Tuolumne County 
APCD 

  



 

 

Sub-Area County 
Name 

Air Basin 
Name Air District Name MPO MPO Name 

Ventura (SCC) Ventura 
South 
Central 
Coast 

Ventura County 
APCD 

SCAG 
Southern California 
Association of Governments 

Yolo (SV) Yolo 
Sacramento 
Valley 

Yolo-Solano AQMD SACOG 
Sacramento Area Council of 
Governments 

Yuba (SV) Yuba 
Sacramento 
Valley 

Feather River AQMD SACOG 
Sacramento Area Council of 
Governments 

 

  



 

 

8.3 Vehicle Categories 

EMFAC202Y Description EMFAC202X EMFAC2011 EMFAC2007 
LDA Passenger Cars LDA LDA LDA 

LDT1 
Light-Duty Trucks (GVWR 
<6000 lbs and ETW ≤3750 
lbs) 

LDT1 LDT1 LDT1 

LDT2 
Light-Duty Trucks (GVWR 
<6000 lbs and ETW 3751-
5750 lbs) 

LDT2 LDT2 LDT2 

MDV 
Medium-Duty Trucks (GVWR 
6001-8500 lbs) 

MDV MDV MDV 

MH Motor Homes MH MH MH 
MCY Motorcycles MCY MCY MCY 

LHD1 Public 
Light-Heavy-Duty Public 
Trucks (8501-10,000 lbs) 

LHD1 LHDT1 LHDT1 
LHD1 Other 

Light-Heavy-Duty Other Trucks 
(8501-10,000 lbs) 

LHD2 Public 
Light-Heavy-Duty Public 
Trucks (10,001-14,000 lbs) 

LHD2 LHDT2 LHDT2 
LHD2 Other 

Light-Heavy-Duty Other Trucks 
(10,001-14,000 lbs) 

T6 Public Class 4 
Medium-Heavy Duty Public 
Fleet Truck (14,001-16,000 
lbs) 

T6 Public Class 4 

T6 Public 

MHDT 

T6 Public Class 5 
Medium-Heavy Duty Public 
Fleet Truck (16,001-19,500 
lbs) 

T6 Public Class 5 

T6 Public Class 6 
Medium-Heavy Duty Public 
Fleet Truck (19,501-26,000 
lbs) 

T6 Public Class 6 

T6 Public Class 7 
Medium-Heavy Duty Public 
Fleet Truck (26,001-33,000 
lbs) 

T6 Public Class 7 

T6 Utility Class 5 
Medium-Heavy Duty Utility 
Fleet Truck (16,001-19,500 
lbs) 

T6 Utility Class 5 

T6 Utility T6 Utility Class 6 
Medium-Heavy Duty Utility 
Fleet Truck (19,501-26,000 
lbs) 

T6 Utility Class 6 

T6 Utility Class 7 
Medium-Heavy Duty Utility 
Fleet Truck (26,001-33,000 
lbs) 

T6 Utility Class 7 

T6 Instate Tractor 
Class 6 

Medium-Heavy Duty Tractor 
Truck (19,501-26,000 lbs) 

T6 Instate Tractor 
Class 6 

T6 instate 
small 



 

 

EMFAC202Y Description EMFAC202X EMFAC2011 EMFAC2007 
T6 Instate Delivery 
Class 4 

Medium-Heavy Duty Delivery 
Truck (14,001-16,000 lbs) 

T6 Instate 
Delivery Class 4 

T6 instate 
small 

 MHDT 

T6 Instate Delivery 
Class 5 

Medium-Heavy Duty Delivery 
Truck (16,001-19,500 lbs) 

T6 Instate 
Delivery Class 5 

T6 Instate Delivery 
Class 6 

Medium-Heavy Duty Delivery 
Truck (19,501-26,000 lbs) 

T6 Instate 
Delivery Class 6 

T6 Instate Other 
Class 4 

Medium-Heavy Duty Other 
Truck (14,001-16,000 lbs) 

T6 Instate Other 
Class 4 

T6 Instate Other 
Class 5 

Medium-Heavy Duty Other 
Truck (16,001-19,500 lbs) 

T6 Instate Other 
Class 5 

T6 Instate Other 
Class 6 

Medium-Heavy Duty Other 
Truck (19,501-26,000 lbs) 

T6 Instate Other 
Class 6 

T6 Instate Tractor 
Class 7 

Medium-Heavy Duty Tractor 
Truck (26,001-33,000 lbs) 

T6 Instate Tractor 
Class 7 

T6 instate 
heavy 

T6 Instate Delivery 
Class 7 

Medium-Heavy Duty Delivery 
Truck (26,001-33,000 lbs) 

T6 Instate 
Delivery Class 7 

T6 Instate Other 
Class 7 

Medium-Heavy Duty Other 
Truck (26,001-33,000 lbs) 

T6 Instate Other 
Class 7 

T6 CAIRP Class 4 
Medium-Heavy Duty CA 
International Registration Plan 
Truck (14,001-16,000 lbs) 

T6 CAIRP Class 4 

T6 CAIRP 
small 

T6 CAIRP Class 5 
Medium-Heavy Duty CA 
International Registration Plan 
Truck (16,001-19,500 lbs) 

T6 CAIRP Class 5 

T6 CAIRP Class 6 
Medium-Heavy Duty CA 
International Registration Plan 
Truck (19,501-26,000 lbs) 

T6 CAIRP Class 6 

T6 CAIRP Class 7 
Medium-Heavy Duty CA 
International Registration Plan 
Truck (26,001-33,000 lbs) 

T6 CAIRP Class 7 
T6 CAIRP 
heavy 

T6 OOS Class 4 
Medium-Heavy Duty Diesel 
Out-of-state Truck (14,001-
16,000 lbs) 

T6 OOS Class 4 

T6 OOS small T6 OOS Class 5 
Medium-Heavy Duty Diesel 
Out-of-state Truck (16,001-
19,500 lbs) 

T6 OOS Class 5 

T6 OOS Class 6 
Medium-Heavy Duty Diesel 
Out-of-state Truck (19,501-
26,000 lbs) 

T6 OOS Class 6 

T6 OOS Class 7 
Medium-Heavy Duty Diesel 
Out-of-state Truck (26,001-
33,000 lbs) 

T6 OOS Class 7 T6 OOS heavy 

T6TS 
Medium-Heavy Duty Gasoline 
Truck 

T6TS T6TS 

T7 Public Class 8 
Heavy-Heavy Duty Diesel 
Public Fleet Truck 

T7 Public Class 8 T7 Public HHDT 



 

 

EMFAC202Y Description EMFAC202X EMFAC2011 EMFAC2007 

T7 CAIRP Class 8 
Heavy-Heavy Duty CA 
International Registration Plan 
Truck 

T7 CAIRP Class 8 T7 CAIRP 

 HHDT 

T7 Utility Class 8 
Heavy-Heavy Duty Utility Fleet 
Truck 

T7 Utility Class 8 T7 Utility 

T7 NNOOS Class 
8 

Heavy-Heavy Duty Non-
Neighboring Out-of-state 
Truck 

T7 NNOOS Class 
8 

T7 NNOOS 

T7 NOOS Class 8 
Heavy-Heavy Duty 
Neighboring Out-of-state 
Truck 

T7 NOOS Class 8 T7 NOOS 

T7 Other Port 
Class 8 

Heavy-Heavy Duty Drayage 
Truck at Other Facilities 

T7 Other Port 
Class 8 

T7 Other Port 

T7 POAK Class 8 
Heavy-Heavy Duty Drayage 
Truck in Bay Area 

T7 POAK Class 8 T7 POAK 

T7 POLA Class 8 
Heavy-Heavy Duty Drayage 
Truck near South Coast 

T7 POLA Class 8 T7 POLA 

T7 Single 
Concrete/Transit 
Mix Class 8 

Heavy-Heavy Duty Single Unit 
Concrete/Transit Mix Truck 

T7 Single 
Concrete/Transit 
Mix Class 8 

T7 Single T7 Single Dump 
Class 8 

Heavy-Heavy Duty Single Unit 
Dump Truck 

T7 Single Dump 
Class 8 

T7 Single Other 
Class 8 

Heavy-Heavy Duty Single Unit 
Other Truck 

T7 Single Other 
Class 8 

T7 Tractor Class 8 
Heavy-Heavy Duty Diesel 
Tractor Truck 

T7 Tractor Class 8 T7 Tractor 

T7 SWCV Class 8 
Heavy-Heavy Duty Solid Waste 
Collection Truck 

T7 SWCV Class 8 T7 SWCV 

T7IS 
Heavy-Heavy Duty Gasoline 
Truck 

T7IS T7IS 

PTO Power Take Off PTO PTO 
SBUS School Buses SBUS SBUS SBUS 
UBUS Urban Buses UBUS UBUS UBUS 
Motor Coach Motor Coach Motor Coach Motor Coach 

OBUS 
OBUS Other Buses OBUS OBUS 

All Other Buses All Other Buses All Other Buses 
All Other 
Buses 

 

  



 

 

8.4 Summary of Run Parameters for Generating Custom Activity 
Template 

Tab Run Parameters  Description 

Area 
Area Type One of the area types can be picked. 
Area One or more areas can be selected for one run. 

Time 

Calendar Year 
Between 2000 and 2050. One or more calendar 
years can be selected for one run. 

Season/Month 
One of the three seasons (annual, summer, winter) 
or one of the 12 months can be selected for one 
run. 

VMT 
VMT Type 

Whether input VMT is by daily total or by vehicle 
and fuel type. 

Hourly Speed Fractions Whether to include custom hourly speed fractions. 
SB375 Whether it is a SB375 template. 

 

  



 

 

8.5 Summary of Run Parameters for Generating Emission Rates 

Tab Run Parameters Description 

Area 
Area Type One of the area types can be picked. 

Area One or more areas can be selected for one run. 

Time 

Calendar Year 
Between 2000 and 2050. One or more calendar 
years can be selected for one run. 

Season/Month 
One of the three seasons (annual, summer, 
winter) or one of the 12 months can be selected 
for one run. 

Vehicles 

Vehicle Category 
Type 

Output by EMFAC202Y vehicle category, 
EMFAC202X vehicle category, EMFAC2011 
vehicle category, EMFAC2007 vehicle category, 
Truck/Non-Truck, or Truck1/Truck2/Non-Truck  

Vehicle Category 
One or more vehicle classes can be picked for 
one run. 

Model Year 
Aggregated or by model year in output. One or 
more model years can be selected if by model 
year is picked. 

Fuel Aggregated or by fuel in output. 
Speed One or more speeds can be selected. 

Meteorology 
Temperature Temperature in Fahrenheit 
Relative Humidity Relative Humidity 

Output Pollutants Pollutants in output 
 Output Directory Where to save output files 

  



 

 

8.6 Fields in CTF File 

Field Name Field Type Field Description 
YEAR NUMERIC Cal Year Of The Run Data 
DIS CHAR District Id 
AB CHAR Air Basin Id 
CO NUMERIC County Id 
EIC NUMERIC Eic Code 
PR NUMERIC (11,2) Annual Process Rate 
HPDY NUMERIC Hours Per Day 
DPWK NUMERIC Day Per Week 
JANT NUMERIC(4,1) Percent Activity For January - Range 0-100 
FEBT NUMERIC(4,1) Percent Activity For February - Range 0-100 
MART NUMERIC(4,1) Percent Activity For March - Range 0-100 
APRT NUMERIC(4,1) Percent Activity For April - Range 0-100 
MAYT NUMERIC(4,1) Percent Activity For May - Range 0-100 
JUNT NUMERIC(4,1) Percent Activity For June - Range 0-100 
JULT NUMERIC(4,1) Percent Activity For July - Range 0-100 
AUGT NUMERIC(4,1) Percent Activity For August - Range 0-100 
SEPT NUMERIC(4,1) Percent Activity For September - Range 0-100 
OCTT NUMERIC(4,1) Percent Activity For October - Range 0-100 
NOVT NUMERIC(4,1) Percent Activity For November - Range 0-100 
DECT NUMERIC(4,1) Percent Activity For December - Range 0-100 
POL NUMERIC Pollutant Code 
EMFACT NUMBER (10,4) Emission Factor (Lbs Per Eic Unit) 
SEASON CHAR Season 
EMS NUMERIC(10,4) Emissions (Tons/Day) 
VERSION CHAR Emfac Version 
OPERATOR CHAR Operator Initials 
TDATE DATE Transaction Date 
VMT NUMERIC Vehicle-Miles Traveled 
VEH_POPULATION NUMERIC Vehicle Population 
FUEL_CONSUMPTION NUMERIC Fuel Consumption (Thousand Gallons) 
FUEL_TYPE CHAR Fuel Type 
OP_DAYS NUMERIC Operation Days Per Year 

 

 

 

  



 

 

8.7 EMFAC2025-PL Emission Rate Aggregation (Units and Activity) 

Process type Unit Vehicle Specific Activity 
Running Exhaust grams/vehicle-mile Daily VMT by speed 
Start Exhaust grams/vehicle-start Number of starts per day 

Idle Exhaust 
grams/vehicle-idle 
hours 

Number of idle hours per 
day 

Hot Soak Evaporative grams/vehicle-start Number of starts per day 

Running Loss Evaporative 
grams/vehicle-
operation hour 

Operation hours per day 

Diurnal Loss Evaporative 
grams/vehicle-cold 
soak hour 

Cold soak hours per day 

Brake Wear grams/vehicle-mile Daily VMT by speed 
Tire Wear grams/vehicle-mile Daily VMT (over all speeds) 

  



 

 

8.8 Project Level APS Emission Rates  

Model Year Range pre 2007 2007+ 
HC (g/hr-veh) 3.2 3.2 
CO (g/hr-veh) 6.2 6.2 
NOx (g/hr-veh) 12.1 12.1 
PM (g/hr-veh) 0.87 0.13 
CO2 (g/hr-veh) 2228 2228 
TOG (g/hr-veh) 4.61 4.61 
ROG (g/hr-veh) 4.05 4.05 
SOx (g/hr-veh) 0.02 0.02 
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